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End-User License Agreement and Limited Product Warranty  
Southern Vision Systems Software Product(s) 

  
 

IMPORTANT—READ CAREFULLY: This Southern Vision Systems End-User License Agreement (“EULA”) is 
a legal agreement between you (either an individual or a single legal entity) and Southern Vision Systems, Inc. 
(“SVSi”).  By installing, copying, downloading, accessing or otherwise using the SOFTWARE PRODUCT, you 
agree to be bound by the terms of this EULA.  You agree that this EULA is enforceable like any written, 
negotiated contract signed by you.  If you do not agree to the terms of this EULA, do not download, install or 
use the SOFTWARE PRODUCT; you may, however, return it to the place where you obtained it. 
 
1.  Limited License Grant. Southern Vision Systems, Inc. grants to you (“Licensee”) a non-exclusive, 

limited license to use the Software.  Licensee may make one archival copy of the Software. Licensee may 
not re-distribute the Software in whole or in part, either separately or included with a product.  

   
2.  Restrictions. Software is confidential copyrighted information of SVSi and title to all copies is retained 

by SVSi and/or its licensors.  Licensee shall not modify, decompile, disassemble, decrypt, extract, or 
otherwise reverse engineer Software. Software may not be leased, or sublicensed, in whole or in part. 
Licensee may transfer all rights under this License on a permanent basis provided that Licensee transfers 
the license, the Software and all associated printed materials, retains no copies and the recipient agrees to 
the terms of this License.   

   
3.  Trademarks and Logos. This License does not authorize Licensee to use any SVSi name, trademark or 

logo. Licensee acknowledges that SVSi owns the SpecterView, MemView, iCi, and GigaView trademarks 
and all related trademarks, and logos and agrees to: (i) not do anything harmful to or inconsistent with 
SVSi’s rights; and (ii) assist SVSi in protecting those rights, including assigning to SVSi any rights 
acquired by Licensee. 

 
4.  Disclaimer of Warranty. Software is provided “AS IS,” without a warranty of any kind. ALL 

EXPRESS OR IMPLIED REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED 
WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-
INFRINGEMENT, ARE HEREBY EXCLUDED. 

 
5.  Limitation of Liability. SVSi AND ITS LICENSORS SHALL NOT BE LIABLE FOR ANY 

DAMAGES SUFFERED BY LICENSEE OR ANY THIRD PARTY AS A RESULT OF USING OR 
DISTRIBUTING SOFTWARE. IN NO EVENT WILL SVSi OR ITS LICENSORS BE LIABLE FOR 
ANY LOST REVENUE, PROFIT OR DATA, OR FOR DIRECT, INDIRECT, SPECIAL, 
CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED AND 
REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR INABILITY 
TO USE SOFTWARE, EVEN IF SVSi HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.       

 
6.  Termination. Licensee may terminate this License at any time by destroying all copies of Software. This 

License will terminate immediately without notice from SVSi if Licensee fails to comply with any 
provision of this License. Upon such termination, Licensee must destroy all copies of Software. 

 
7.  Export Regulations. Software, including technical data, is subject to U.S. export control laws, including 

the U.S. Export Administration Act and its associated regulations, and may be subject to export or import 
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regulations in other countries. Licensee agrees to comply strictly with all such regulations and 
acknowledges that it has the responsibility to obtain licenses to export, re-export, or import Software. 
Software may not be downloaded, or otherwise exported or re-exported (i) into, or to a national or resident 
of Cuba, Iran, North Korea, Libya, Sudan, Syria or any country, organization or person to which the U.S. 
has embargoed the export of goods; or (ii) to anyone on the U.S. Treasury Department’s list of Specially 
Designated Nations or the U.S. Commerce Department’s Table of Denial Orders. 

 
8.  Restricted Rights. Use, duplication or disclosure by the United States government is subject to the 

restrictions as set forth in the Rights in Technical Data and Computer Software Clauses in DFARS 
252.227-7013© (1) (ii) and FAR 52.227-19(c) (2) as applicable.  

 
9.  Governing Law. Any action related to this License will be governed by Alabama state law and 

controlling U.S. federal law. No choice of law rules of any jurisdiction will apply. 
 
10.  Severability. If any of the above provisions are held to be in violation of applicable law, void, or 

unenforceable in any jurisdiction, then such provisions are herewith waived to the extent necessary for the 
License to be otherwise enforceable in such jurisdiction. However, if in SVSi's opinion deletion of any 
provisions of the License by operation of this paragraph unreasonably compromises the rights or increase 
the liabilities of SVSi or its licensors, SVSi reserves the right to terminate the License and refund the fee 
paid by Licensee, if any, as Licensee's sole and exclusive remedy.  

  
11. Notice.  The GigaView, MemView and SpecterView trademarks are owned by SVSi.  A patent is 

pending on the Image-Cued Trigger feature described herein. 
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IMPORTANT SAFETY INSTRUCTIONS 
  

DO NOT DISCARD, READ BEFORE OPERATING  
 
 

Please read the safety precautions carefully before using this product.  Ensure that you use the product correctly 
according to the procedures described in these instructions.   
 
The following safety precautions are intended to instruct you in the safe and correct operation of the product 
and its accessories to prevent injuries or damage to yourself, other persons, and property.  Please read and 
ensure that you understand them before you proceed to the other sections of these instructions. 
 

 
 

• Do not operate this device in a wet environment. 
• Refer servicing to qualified service personnel only. 
• Please read the Operating Manual carefully before operating.  Follow all operating and other 

instructions carefully. 
• This device should only be operated with the accompanying power adaptor. 
• Do not use this product near heat sources such as radiators, air ducts, areas subject to direct, 

intense sunlight, or other products that produce heat. 
 

 
WARNING   

 
Do not play the supplied CD-ROM in any CD-ROM Player that does not support data CD-ROMs.  The 
extremely loud sound that may result from playing the CD-ROM in an audio CD player (music player) 
could damage the speakers.  It is also possible to suffer hearing losses from listening with headphones to 
the loud sounds of a data CD-ROM played on a music CD player. 
 
 
 
Disclaimer 
 

• While every effort has been made to ensure that the information contained in these instructions is 
accurate and complete, no liability can be accepted for any errors or omissions.  SVSi reserves 
the right to change the specifications of the hardware and software described herein at any time 
without prior notice. 

 
• SVSi makes no warranties for damages resulting from corrupted or lost data due to mistaken 

operation or malfunction of the GigaView camera, software, or accessories. 
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This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to 
Part 15 of the FCC Rules.  Additionally, this equipment has successfully met all of the requirements for CE 
certification.  These limits are designed to provide reasonable protection against harmful interference in a 
commercial installation.  This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference to radio communications.  
However, there is no guarantee that interference will not occur in a particular installation.  If this equipment 
does cause harmful interference to radio or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following 
measures: 
 

• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected. 
• Consult the dealer or an experienced radio/TV technician for help. 

Modifications not expressly approved by the manufacturer could significantly affect the level of harmful 
interference. 
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1.0   SYSTEM REQUIREMENTS 

Operating System Windows 2000/XP Professional (recommended) 
RAM Minimum 256 MB required 

512 MB (recommended) 
Processor Pentium class or equivalent 
Interface Gigabit Ethernet (TCP/IP) 
Hard Disk Space Camera memory + 10 MB minimum 
Display 1024 x 768, Color (32-bit) minimum 
Lens 1” C-mount 

35-mm (requires C-mount adapter) 
 
 
 
2.0 FRONT AND BACK VIEW OF CAMERA

 
FRONT VIEW  

 
BACK VIEW

Figure 1.  Front and back panel views of GigaView 
 

The front panel has only the c-mount connector for attaching a lens to GigaView.  
  

Back Panel Connection Function 
Power 2A @ +24V through supplied AC adapter 
Gigabit Ethernet Interface to host computer – cable not supplied  
External Trigger Input External (5V TTL) trigger input or switch closure 
IRIG-B Input External AM-modulated time code (upgrade option) 
Analog Video RS-170 (640x480) output  
Digital Out 3.3V TTL output (synchronized to frame exposure by 

default) 
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3.0 QUICK-START GUIDE 

Your GigaView Gigabit Ethernet camera comes with a power adapter, operating manual, and software CD.  
Using your gigabit Ethernet GigaView camera for the first time: 
 

1. Install software from installation CD after reading Software User License Agreement. 

2. Power-up the camera.  The two LEDs on the back panel will come on continuously during power-up 
sequence.  Once power-up sequence is finished, the amber and green lights are on steady.  At this point, 
GigaView is recording into a rolling buffer 1280x1024 images at 120fps with an exposure of 8-msec in 
10-bit mode while waiting for an external trigger.  By applying either a +5V signal or switch closure to 
the “External Trigger” connection on the back panel, the recording process is stopped and video is 
stored to on-board memory.   The camera may then be connected to a network or directly to the host 
computer to download imagery or to stop the record process if an external trigger was not received.  A 
cross over cable is not required when connected directly to the computer. 

3. Connect the camera directly to the host or to a network.  A crossover cable is not required when 
connecting directly to the computer.  GigaView can be connected through 10/100 or 1000-baseT 
connections but download rates will be significantly higher over gigabit Ethernet. 

4. If your GigaView camera is connected through a network, skip to step 4.  If camera is directly connected 
to the host computer, DHCP must be turned off on the host Ethernet network connection.  Under the 
host computer’s [Control Panel->Network Connections], select the Ethernet connection for the camera 
and right-click on “Properties.”  Under the [General->Internet Protocol (TCP/IP)->Properties] menu 
item, select [Use the following IP address:] and enter a fixed IP address that is not already being used on 
a network.  Your network administrator can provide this data.  
Example:  IP Address:  192.168. 1. 82 
                                   Subnet Mask:  255.255.255.0 
                                   Default Gateway: 192.168. 1. 1 
(Note: do not use an IP address of 192.168.1.199 for the host computer as that is reserved for 
GigaView.) 

5. Important:  every GigaView camera is shipped with the default IP address of 192.168.1.199 and an 
MTU size of 1500.  GigaView supports a maximum transfer unit size of 9,000 for faster downloads.  If 
you wish to change the IP address or MTU size, double-click on the “NetworkConfig” icon that was 
installed on your desktop during installation.  A screen similar to that below will appear. 
  
  
  
  
  
  
  
  
  
  
  
  



3 

GigaView supports auto-discovery so that every camera connected to the host (either directly or through 
a network) will show up on the window above.  To change the network configuration properties of a 
camera, select that camera and click [OK].  The screen below will appear. 

 

6. Once connected, you may set new values including camera name, MTU size, and IP address.  To set the 
MTU size, select a size that is less than or equal to the maximum MTU size supported by the host 
computer network connection and any hub, router, or switch between the host computer and camera.  
This information can be obtained from your network administrator or found in the supporting 
documentation for the host computer, interface card, hub, router, or switch on the network.  If maximum 
MTU size for your hardware is not known, leave default as 1500.  The camera supports MTU sizes up to 
9,000-bytes.  It will also recognize a lower speed connection and auto-negotiate down to 10/100-baseT. 

7. Once the camera name, IP address, or MTU size has been modified, click [Update] then [Reboot] for the 
changes to take effect. 

8. After software installation and IP configuration, the camera should be ready for use.  

9. Select the [Camera->Open Ethernet Camera] menu item. The auto-discovery screen shown above will 
appear asking you to select the camera to connect. 

10. Once connected, the camera will begin displaying video recorded at 120-fps, 8-msec exposure, and 
1280x1024 in 10-bit.  Click [Stop] to halt capture and adjust recording parameters. 

Note: If communications with your gigabit Ethernet GigaView are lost, try resetting the camera by selecting 
[Camera->Reset Camera] under the “Record” page menu bar.  This will not cause you to lose data in 
memory.  If resetting still does not work, exit out of the program and run the “NetworkConfig.exe” program 
installed on your desktop during installation.  Select the IP address and hit “Connect.”  This should only 
take a few seconds after which the camera information will appear in the fields.  Next click “Reboot” to 
reload the control logic into the camera.  NOTE: this will cause data stored in memory on the camera to be 
lost.  After the reboot sequence is complete, close the “NetworkConfig.exe” window and start the GigaView 
software again. 
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4.0 GIGAVIEW OPERATING MODES 

The GigaView high-speed camera system is designed to record and playback imagery in a user-friendly manner.  
The two operating modes are Record and Play.  Implementation, specifications, data logging and display, and 
limitations on use for all modes are described below. 
 
 
4.1 INITIALIZATION 

When the GigaView application is started, the default “Play” window appears as shown in Figure 3.  Data files 
can be opened and played in this mode whether a camera is attached or not.  AVI files must be 8-bit or 24-bit and 
are limited to a 2-GB file size.  The codec for the AVI file being played must be available on your computer.  
The sections below describe how to set up each mode for optimal data acquisition and display. 
 
 
4.2 PLAY MODE 

The “Play” window is shown below as the GigaView software is initializing. 
 

 
Figure 2.  GigaView GUI during initialization. 
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Figure 3.  GigaView "Play" window. 

 
Common video controls (Forward/Reverse/FF/Stop) are available on the main control page and on each 
individual window.  Multiple windows can be opened at once.  The current frame is indicated below a sliding bar 
that can be dragged to a particular frame.  Another sliding bar allows the Playback Rate to be set up to 40 
frames-per-second (fps).  Media files can be played in a loop by selecting the  button.   
 
Information about the original recording parameters of the video are shown in the “Recorded Info” are and 
include: frame size, frame rate, number of frames, and time duration.  Frame size and frame number are also 
shown in the lower right of the main page. 
 
The player supports playing native GigaView RAW files (*.mvw) and AVI files (limited to 2GB). It can also 
display single images (bitmap, jpeg, tiff, and raw).  Use the File Open command to select the file type and the 
file to open.  The “Save As” command allows you to save the video files with different options. You can save a 
previously recorded GigaView file as a new GigaView file with different frame parameters; you can save it as an 
AVI file; or you can save it as a series of images.  See the description of the “Save Data” dialog below on the 
various options. 
 
Note: because of the large file sizes generated during a typical record session, SVSi recommends 
recording and playing in the default *.mvw file format.  This file format gives the fastest download times 
and smallest file sizes.  Once actual frames are identified for public dissemination, then AVIs, BMPs, or 
TIFFs can be generated from the “Play” page. 
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4.3 RECORD MODE 

The “Record” window is shown below.  To access this page, click on the [Camera-->Open Ethernet Camera] 
menu.  The window of Figure 4 appears once the connection to the camera is established.  The Open Ethernet 
Camera command will search all relevant mac addresses for a camera and load it.  Depending on the network 
and host computer Ethernet configuration, this could take up to a minute.  Normally the Ethernet camera should 
open in a matter of seconds. 
 

The [Record] button brings up the Record Wizard that presents a series of windows that walk the user through 
selection of frame-size, frame-rate, exposure, recording time, trigger source, and other options such as auto-
exposure and sector recording.  The Record Wizard is designed to make set-up and operation as simple as 
possible.  However, it can be bypassed by typing [Ctrl-R] on the keyboard or by selecting [Camera->Record] 
from the drop-down menu on the “Record” page.   
 

The GigaView sensor is a large-area, high-speed, CMOS sensor.  The image sensor size is 15mm x 12mm and is 
compatible with 1” C-mount or 35-mm lenses.  A C-mount to F-mount adapter will be needed to adapt to the 
bayonet mount on most 35-mm lenses.  By adjusting the size of the frame downloaded from the sensor, frames 
can be captured at rates between 30-17,045Hz.  Memory options allow up to 16-GB of digital imagery.  This 
equates to 12-secs of video at 1280x1024. Selectable frame sizes as shown in Table I are 1280x1024, 1280x960, 
1280x512, 1280x256, 1280x128, 1280x32, 640x512, 640x512, 320x256, 160x128 and 720x480 for standard 
GigaView.  For the low-resolution version, GigaView-LR, selectable frame-sizes are 640x480, 640x256, 
640x128, 640x32, 320x256, and 160x128. 

 

Figure 4.  GigaView "Record" window. 
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Information about record time, maximum frame count, and frame rate are shown on the left side of the window.  
As soon as the “Record” page appears, GigaView starts capturing and displaying frames at 60-Hz with full-
frame and 30-msec exposure time.  User-adjustments are allowed to frame size, frame rate, exposure, record 
time, or number of frames.  When one of these parameters is entered manually, the others will be modified as 
needed.  Once parameters are entered, clicking on [Update] sends these new parameters to GigaView.  [Live] 
does not store imagery to memory and is intended for alignment and setup purposes.  Once lighting, focus, and 
exposure are adjusted, clicking [Record] saves the required number of frames to memory on the camera.  
During “Live”, “Record”, and “Standby” modes, analog video is output through the “Analog Video” rear-panel 
BNC connector.  Text strings can be overlaid on the analog video by entering the strings under the [Camera-
>Analog Text Settings…] menu item.  If IRIG timing is enabled, a text overlay of IRIG time will appear on the 
video.  Other text strings can be entered under the [Camera->Analog Text Settings…] menu item. 
 
Images viewed in the “Record” window are stored in the camera and will not be downloaded to hard disk until 
the “Save” or “Save Current Image” command on the File menu has been selected.  The video stored in camera 
memory can be viewed by selecting the number of frames to skip during playback and selecting “Play”.  Frames 
can also be viewed on a frame-by-frame basis by clicking on the frame scroll bar along the bottom of the 
“Record” window and using the left and right arrows. 
  
The “Post Process” section allows playback of the imagery on the camera.  The imagery will remain on volatile 
memory within the camera until [Record] is clicked again or the power to the camera is removed.  In either of 
these events, imagery will be irretrievably lost.     
 

4.3.1 FRAME RATE 
Frame rate is indicated in the “Video Settings” portion of the “Record“ window and can be selected 
either through the Record Wizard or by entering directly inside the “Video Settings” part of the “Record” 
window.  The maximum frame rate is determined by the frame size.  The selected frame rate determines 
the minimum and maximum exposure.  Frame capture rates are selected from a drop-down list or entered 
by hand to 1-Hz precision.  Allowable exposure times are adjusted based on the selected frame-rate and 
allowable frame-rates adjusted based on selected frame-size.  The table below lists the frame-rates for a 
given frame size and exposure.  Note some older camera models have slightly lower frame rates 
(maximum of 488 fps). 
 

Table 1  Exposure and frame-rate values for various frame-sizes. 

Frame Size (pixels) Exposure Frame Rate 

1280 x 1024 2µsec-1877µsec 
>1877µsec 

532fps 
1/Texp 

1280 x 960 2µsec-1785µsec 
>1785µsec 

568fps 
1/Texp 

1280 x 512 2µsec-936µsec 
>936µsec 

1065fps 
1/Texp 

640 x 512 2µsec-1065µsec 
>1065µsec 

1065fps 
1/Texp 

640 x 480 2µsec-1136µsec 
>1136µsec 

1136fps 
1/Texp 

1280 x 256 2µsec-467µsec 2130fps 
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>467µsec 1/Texp 

320 x 256 2µsec-467µsec 
>467µsec 

2130fps 
1/Texp 

160 x 128 2µsec-232µsec 
>232µsec 

4261fps 
1/Texp 

1280 x 128 2µsec-232µsec 
>232µsec 

4261fps 
1/Texp 

720 x 480 2µsec-1136msec 
>1136µsec 

1,136fps 
1/Texp 

1280 x 32 2µsec-56µsec 
>56µsec 

17,045fps 
1/Texp 

 
 
4.3.2 TRIGGER SETTINGS 
GigaView can be triggered internally or externally to capture images with an option for triggering on the 
rising or falling edge of an external trigger.  With [External Trigger] or [Frame Sync] selected, GigaView 
will wait for a TTL pulse to be applied to the rear panel BNC connector before recording images.  The 
[Trigger Settings] dialogs for externally triggering are shown below and are accessed by clicking on the 
[Trigger Settings] menu item or through the Record Wizard. 
 
 

 
Figure 5.  External trigger settings. 

 

 
Figure 6.  Frame Sync Trigger Settings 
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With [External Trigger] enabled and a single 3-5V signal applied to the “Ext Trigger” input, GigaView 
captures the specified number of frames at the equivalent frame-rate and then stops.  Recording can be 
triggered off the rising or falling edge of the trigger pulse.  The user-definable delay determines how long 
after the trigger edge the first frame is captured.  This delay ranges from 0.002-60,000-msec and can be 
used in conjunction with pre- and post-trigger settings. 
 
The [Frame Sync] trigger option captures one frame per trigger at a rate just below GigaView’s maxi-
mum frame-rate.  To fill up memory using the [Frame Sync] settings, GigaView has to see multiple 
trigger pulses.  Once memory is full, the record process is stopped and frames can be downloaded.  The 
frequency of trigger pulses may vary during the record process but the user should be aware that varying 
the trigger frequency significantly may change the relative signal intensities frame-to-frame.  This is 
because GigaView’s quiescent operating conditions are closer to static conditions the longer the pixel 
signal transfer is held off waiting for a new trigger pulse. 
 
4.3.3 GAIN SETTINGS 
GigaView has the option of adjusting the imager gain setting independent of exposure.  Gain settings are 
accessed under the drop-down [Camera->Set Gain] menu item and are limited to +8dβ, +5dβ, +2dβ, 0dβ, 
-1dβ, and -2dβ.  For low-light levels, the “+” dβ levels increase imager gain but at the expense of higher 
noise.  When image quality or quantitative measurements are important, the “-“ dB gain settings may 
show improvement.  Figure 7 below shows how to access these gain settings. 
 

 
Figure 7  Gain Settings 

 
NOTE – some older camera models do not support this function.  If your camera does not support this 
feature, the menu item will not appear in the software. 
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4.3.4 FOCUS INDICATOR 
To aid in focusing the camera, a focus indicator bar is available either through the Record Wizard or 
through the drop-down menu item [View->Focus].  This bar is shown below and indicates best focus 
when the lower blue section of the bar is maximized.  When enabled, the user should use his mouse to 
position the 128x128 box over the object to be focused.  Once positioned correctly, left clicking the 
mouse will anchor the box.  Move the mouse to another location and left-click to change the box 
location.  Right-click the mouse to permanently anchor the focus box.  The focus indicator dynamically 
scales the focus bar to offer best resolution.  Select [Reset] on the focus indicator bar to bring the focus 
scale to its minimum value.  Select [Close] to close the focus indicator window.  
 

 
Figure 8  Focus Indicator 

 
 
4.3.5 STORING IMAGERY 
Images can be stored from GigaView in several ways.  The [File Save] command allows the data to be 
saved as a GigaView RAW file, an AVI file or a sequence of individual image files.  The GigaView 
RAW file format can be played with the GigaView player and any player that supports RAW data.  AVI 
files can be played with the GigaView player or with third-party software.  There are numerous software 
applications that can display individual files, including the GigaView player.  If more than one file is 
needed, the given filename will be used to name the file followed with a numerical value.  Sequence of 
images will be stored as <filename_001.raw>, <filename_002.raw>, …<filename_nnn.raw> in the 
specified directory.  The currently displayed frame can be saved using the [File Save Current Image]  
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command.  Images recorded with GigaView will remain in volatile memory on the camera until they are 
over written by a new record operation or when the camera loses power.  If the user elects to exit the 
software without saving the imagery, a warning window pops up indicating that data may be lost.  As 
long as the camera maintains power, the data will remain in the camera.  You may exit the software and 
reconnect to it later to retrieve the data. 
 
Prior to saving the data, the user should scroll through the recorded imagery to identify the start and stop 
frames of interest.  In many cases, the storage requirements can be greatly reduced by eliminating 
unneeded frames before or after the event of interest.  The scroll bar below the image window in Figure 4 
can be used to identify the first and last frame of interest by clicking and dragging.  The current frame is 
indicated both in the “Current Frame” window and in the status bar of the Record dialog. 
 
The Save Data Dialog allows you to set the start and end sectors and start and end frames for the data.  It 
lets you select several other options described below. 
 

 
Figure 9  File save options window. 

 
File name – Enter the filename that you would like to use for the stored file.  If more than one file needs 
creating, this name will be used to generate the filenames.  For example, if two files need to be created 
and you enter C:\Data\GigaView.avi, they will be created as C:\Data\GigaView_001.avi and 
C:\Data\GigaView_001.avi. 
 
File type –  supported file types stored from the “Record” page are AVI(.avi), GigaView raw(.mvw), or 
sequences of bitmap(.bmp), raw(.raw), JPEG(.jpg), or TIFF(.tiff) images.  The smallest destination files 
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and the fastest download times are realized for GigaView raw files.  Image sequences are stored with 
consecutive numbering starting from _0001. 
 
Number of files – indicates the number of files that will be created. 
 
Estimated Disk Space – gives an estimate of the required disk space to create the file(s). 
 
Sectors – saves all sectors at one time or specifies the sectors to save.  Each sector will be saved as a 
separate file.  The naming convention would be C:\Data\GigaView_s00.mvw, 
C:\Data\GigaView_s01.mvw for two sectors. 
 
Frames – allows you to specify all frames should be saved to the AVI or you may specify the start, stop 
and frame step size to use. 
 
Generate Auxiliary Data File – Selecting this option will result in an external data file to be generated 
which contains timing and exposure settings for each frame.  The filename is the same as the data file 
with the .mvd file extension.  The exposure setting is the exposure of the frame.  For auto exposure mode, 
this value could differ for each frame.  For non auto exposure mode, this value will be the same for all 
frames. 
 
The File menu also contains an Options item.  This command will display the following Options dialog: 
 

 
Figure 10.  Options Dialog Window. 

 
Display Alert – This option will cause an alert message to be displayed when capture has been 
completed.  This is useful when you are using a trigger to end your capture session.  Note, if the next 
option is selected for auto saving the data, this alert will not be displayed but a message will be displayed 
the data has been saved. 
 



13 

Save Data after capture – The option will cause GigaView to automatically save the data after the 
capture session is complete.  All frames and sectors will be saved.  The filename, type and other options 
are the same as in the Save Data dialog above. 
 
A dialog will be displayed listing the files that were created.   
 
 
4.3.6 LIGHTING CONDITIONS 
The CMOS imager in GigaView is much more sensitive to infrared (IR) wavelengths present under many 
lighting conditions than is the human eye.  This IR radiation can cause the imagery to appear washed-out 
and blurry.  To obtain “true color” imagery and high resolution, an IR cut-off filter has been installed on 
your camera.  If near-IR sensitivity is desired, this filter can be removed with factory support. 
 
Color response of the GigaView camera can be set using one of three settings: [Auto], [Ambient], or 
[Manual].  The [Auto] setting adjusts the color coefficients using an automatic white balance algorithm.  
An image is sampled to determine the nominal “white” values within a frame and the red/green/blue 
coefficients in the Bayer mask are adjusted accordingly and applied to subsequent frames.  This process 
occurs whenever [Live] or [Record] buttons are clicked.  Note that if the first image acquired is dark and 
has no representative “white” value, the color balance may be noticeably off.   
 
The [Ambient] setting uses a pre-defined set of color coefficients when generating color imagery.  These 
coefficients should be optimal for most lighting conditions.  For those lighting conditions that deviate 
noticeably from “true color”, the user can select the [Manual] setting.  In this mode, four color coefficient 
entry boxes appear below the image as in Figure 6.  The default values will appear in the four boxes but 
the user can adjust these values to give the truest color.  Care must be taken since these coefficients will 
change for various lighting conditions and IR filter configurations. 
 

 
Figure 11.  [Manual] entry of color coefficients. 
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The View menu contains the command “Reduce FPN” to reduce fixed pattern noise in grayscale images.  
The command performs a smoothing option along the horizontal axis of the image.  When this option is 
turned on, it will affect the displayed image and the AVI file but not the raw data.  This option is not 
available on color camera. 
 
 
4.3.7 DIGITAL OUTPUT 
Many tests require scheduling between different instruments.  The Digital Output feature allows the user 
to select between four different digital outputs.  The Digital Output options are: 
 
1. Frame Toggle (default) – the TTL level transitions from low-to-high or high-to-low on every 

frame done.  The frequency of this signal is one-half the true frame-rate. 
2. Strobe Out – a TTL pulse of duration 1-µsec is generated at the start of every frame.  This 

signal would be used for synchronizing a strobe light to your GigaView.  The user can enter 
an adjustable delay in order to optimize strobe timing. 

3. Trigger Out – a TTL pulse is generated whenever a trigger (either internal or external) is 
detected by GigaView.  Only one trigger is generated for every record event.  For sector 
record, only one trigger will be generated per sector. 

4. External Trigger Follow – a TTL pulse is generated with the same rise and fall as the input 
external trigger.  Max delay between external trigger and trigger follow is 30-nsec. 

 
 
4.3.8 IRIG TIMING 
Cameras equipped with an internal IRIG card can timestamp frames with IRIG-B timing.  The time is 
embedded into the first 10 bits of the frame.  The time is displayed during record and playback on the 
status bar at the bottom of the window.  A green indicator is displayed beside the time when the IRIG 
time generator is in sync.  The indicator is red when the time is not in sync.  This time is saved with the 
AVI file and also in the auxiliary data file.  The IRIG Timing command allows you to turn on/off IRIG 
time stamping and also allows you to manually set the IRIG time on the camera. 
 

 
Figure 12  Setting IRIG-B year and options. 
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4.3.9 AUTONOMOUS OPERATION 
GigaView is capable of autonomous operation when the [Disconnect] button of Figure 6 is selected.  
Once trigger source, exposure, frame-size, frame-rate, and lighting conditions are all selected, selecting 
[Record] causes GigaView to wait for the appropriate trigger signal before storing imagery.  If the trigger 
event is indeterminate or only occurring after a long delay, by selecting [Disconnect] and unplugging the 
Ethernet cable, GigaView can operate on its own until the trigger signal (either internal, external, or 
optional image-cued) is received.  Once the trigger is detected, frames are stored to memory and 
GigaView waits until connected to the remote host  before downloading frames.  If no trigger signal is 
detected while disconnected, then the number of recorded frames will continue to increase and the 
display will update with live imagery.  
 
Notes on autonomous operation:  
 

1. Power must be supplied to GigaView at all times during autonomous operation.   
2. Care must be taken when unplugging the Ethernet cable to not jar the camera.  This is especially 

important during image-cued operation as a different part of the FOV could cause an inadvertent 
trigger. 

 
 
4.3.10 EVENT LOGGING 
Trigger events can be logged to a text file for a historical record of either external trigger events or 
image-cued trigger events.  The user can specify the log file under the [File->Options] page as shown 
below. 
 

 
Figure 13  Enabling the event logging feature. 
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Once the specified trigger events have occurred, a text file is created with the time and trigger type for 
each event with one event per line.  The video does not have to be saved for the event log to be created or 
updated.  If subsequent recording sessions record events to the same log file, the additional events will be 
appended to the original file until the file is deleted.  A screen capture of such a log file is shown below. 
 

 
Figure 14  Event logging text file example. 

 
Timing for the event log file is based on GigaView’s internal real-time clock and represents the two-digit 
year, three-digit day of the year, then time in hours:minutes: seconds.fractional-seconds. 
 
 
 

4.4 BACK PANEL CONNECTIONS 

Back panel connections are the same for monochrome and color versions of GigaView.  These are described 
below. 
 

4.4.1 GIGABIT ETHERNET 
The digital interface to the host computer is through Gigabit Ethernet.  No cable is supplied with 
GigaView. 
 
4.4.2 POWER +24V 
GigaView requires +24V from the supplied AC power adapter.  The maximum power consumption is 
50W in [Record] mode. 
 
4.4.3 TRIGGER IN  
A +5V TTL signal can be input to this BNC connector to externally trigger the GigaView camera.  
Imagery can be stored both before and after the occurrence of this trigger by using the pre/post-trigger 
settings under the “External Trigger -> Settings” window shown in Figure 5 above. 
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4.4.4 DIGITAL OUT 
A low-voltage (3.3V) TTL signal is generated during [Record] on this BNC connector.  The signal 
transitions are synched to the framing period of the camera so that the frequency of this signal is one-half 
the true frame-rate of the camera.  This signal can be used to synchronize multiple cameras. 
 
4.4.5 ANALOG VIDEO 
RS-170 analog video (640x480 resolution) is output on the BNC connector at all times except when the 
[Stop] button is selected.  The 1280x960 resolution is sub-sampled (every other row and column) to 
generate the reduced 640x480 resolution.  Frame sizes smaller than 1280x960 will show black bands on 
top, bottom, left, and right when displayed on the analog video output. 
 
4.4.6 IRIG-B INPUT 
For IRIG equipped cameras, this port allows you to connect external AM-modulated time code device. 
 
 

 
 
5.0 GIGAVIEW FEATURES 

Your GigaView camera comes standard with several unique features - including video streaming over the 
gigabit Ethernet interface, 10-bit imagery, auto-exposure, sector recording, and image-cued trigger.  It can also 
time-stamp each image with an absolute time derived from an external IRIG-B signal as an optional upgrade.  
These features are described in this section and can be implemented through drop-down menus on the “Record” 
page or through the Record Wizard. 
 
 
5.1 VIDEO STREAMING 

GigaView has the ability to stream video over the gigabit Ethernet interface – either as a stand-alone function or 
at the same time that it is recording to on-board memory in burst mode.  The gige interface is limited to a 
useable streaming rate of 85-MB/sec with 9k MTU size.  This MTU size can be set for your interface adapter 
through the [Properties->Configure->Advanced] setting in the [Network Connections] dialog as in Figure 15 
below.  Not all network interface adapters support 9k jumbo frames so contact your network administrator to 
verify this support. 
 
A hard disk array is required for accepting the steaming video from GigaView.  Typically, 4-5 SATA or SCSI 
drives are required to handle the full streaming bandwidth but this bandwidth also depends on the giga adapter, 
host memory, and host processor.  SVSi can deliver a computer system with storage for up to 8-hours of 
640x480 at 250-fps in either desktop or portable ruggedized configuration. 
 
GigaView’s streaming function is started by clicking on the [Start] button under the “Streaming” section of the 
“Record” page.  A Streaming Wizard pops up to walk the user through the choice of frame-rate, exposure, 
resolutions, and record time similar to the Record Wizard.  If streaming and burst modes are implemented at the 
same time, bursting to on-board memory takes priority and the streaming function downloads frames as it can 
over the gige interface.  For example, if the full frame-rate of 532-fps is selected for burst mode and then 
streaming is enabled with frame down-sampling, GigaView will burst to on-board memory at the full 532-fps 
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but may stream a few frames at 532÷2=266-fps until it can’t keep up, then skip a frame, then go back to 266-fps 
until it can’t keep up, and so forth.  If both burst and streaming rates are set to 250-fps, then there should be no 
interruption of frame sequence if the hard disk array can keep up. 
 

 
Figure 15  Jumbo frame set-up procedure. 

 
The streaming frame size can be selected from a drop-down menu and varies from full 1280x1024 resolution to 
160x128 with a frame-rate equal to 85-MB/sec ÷ (frame-size in MB).  As seen in Figure 16 below, there is an 
option to down sample each image for streaming.  For example, 1280x960 images at 500-fps would be down-
sampled to 640x480 with a corresponding increase in streaming rate compared to the original image size.   
Thus, the field-of-view remains the same as imagery stored in burst mode but frame-rates of 250-fps can be 
sustained over the gige interface. 

 
Figure 16  Streaming options window. 
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The GigaView software evaluates the destination drive to determine how much storage space is available and 
calculates a record time based on this value.  Video can be streamed for up to 8-hours after which recording 
stops or it can be streamed continuously until the host computer is told to stop with the last 8-hours stored on 
the disk for review.  During video streaming, the host computer screen is updated at 1-Hz with streaming video 
parameters.  If GigaView is recording to on-board memory at the same time, no indication is given for burst 
mode until streaming is halted.  Figure 17 is a directory tree showing multiple files created during one recording 
session.   

 
Figure 17  Files created during video streaming. 

 
Upon exiting the “Record” page into the “Play” page, the master file “streaming.mvw” can be played to view 
the entire 8-hour sequence seamlessly even though multiple video files were originally created.  Note that after 
halting the streaming process, several seconds may be required to empty the video pipeline before the 
GigaView software is enabled. 
 
 
5.2 10-BIT IMAGERY 

GigaView captures and records images with 8-bit or 10-bit grayscale resolution.  Resolution for any recording 
sequence is selected from the “Camera->8-bit Imagery” or “Camera->10-bit Imagery” drop-down menus on the 
[Record] page.  Once selected, several seconds are required for control signals to upload to the camera before 
video can be recorded.  Note: video stored in memory will be lost when changing from 8-bit to 10-bit or vice 
versa.  Capturing and storing 10-bit images provides more information about image intensity at the expense of 
reduced recording time since images are 25% larger.  Images for both 8-bit and 10-bit do not use compression 
algorithms and are raw data. 

 
(Note: the user should be aware that most computer and laptop monitors only display 8-bit so that 10-bit images 
will have to be processed to display correctly.  The GigaView GUI with 10-bit option allows the user to select 
whether the upper, middle, or lower 8-bits of the 10-bit image are displayed and stored.) 
 
A factor of 4 increase in image brightness is seen when displaying the lower 8-bits compared to the upper 8-bits 
and is advantageous for low-light situations.  The same 8-bits displayed will be stored in AVI, BMP, PNG, and 
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TIF formats.  Only the .mvw video and .raw image formats store the entire 10-bit imagery.  In both cases, 10-bit 
images are expanded to create 16-bit files. 
 
 
5.3 IMAGE-CUED TRIGGER  

The image-cued trigger feature rapidly samples a location in the field-of-view of the camera to determine when 
an event has occurred.  When any pixel in the user-defined region either drops below a minimum threshold or 
rises above a maximum threshold, a trigger is generated by the camera to start or stop the recording sequence.  
It is used when the exact start time of an event is not known and reduces the amount of memory required by the 
camera.   
 
The image-cued trigger region is defined either by dragging the mouse across the image or by entering the 
upper-left/lower-right pixels in the [Image Cueing Settings] window. (Note: selecting image-cued trigger 
window with mouse is only allowed in 100% zoom.  Once set, zoom can be changed by right-clicking on 
image.)  This image-cued trigger region can be any area from 10x10-pixels to 1280x1024-pixels and is sampled 
at the nominal frame-rate for an above-threshold event.  Once the camera recognizes the image-cued event, it 
will generate a trigger internally and begin storing frames based on the pre-defined number of pre- and post-
trigger frames.  When used with the 10-bit option described above, image-cueing uses the actual grayscale 
values displayed when selecting upper/middle/lower 8-bits. 
 
The box in Figure 18 below is the image-cued region set up in anticipation of an object passing through the sky.  
The software reports that the current image-cued region has minimum and maximum values of 135 and 174, 
respectively.  Minimum and maximum threshold values should be chosen well below or above, respectively, 
any potential frame-to-frame fluctuation of the pixel signal level (50 for lower and 110 for upper, in this case).  
If any pixel within the image-cued area has a signal level below 50 or above 110, GigaView will generate a 
trigger (either internal or external) to control the recording process.  This trigger will be output through the 
“Digital Out” back-panel connector when “Trigger Out” is selected in the “Camera->Set Digital Out…” drop-
down menu. 
 
Once the threshold has been exceeded, 5% of the available memory will be filled with frames occurring before 
this self-generated trigger and 95% of available memory filled with post-trigger frames.  Once an image-cued 
trigger is generated, the first frame shown after recording is complete is the frame that exceeded image-cued 
threshold conditions and generated the trigger.  During playback, the values in the image-cued trigger region 
can be observed on a frame-by-frame basis.  
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Figure 18.  Image-cued trigger window. 

 
The Image-Cued Trigger Window also allows for a “pre-trigger lockout” period to be defined.  This lockout 
period allows for set-up of the camera and locks out the image-cueing feature until the specified time period has 
expired – 3 seconds in this case.  The pre-trigger lockout starts after “Record” has been started and allows a user 
to walk in front of the camera within that period without generating a false trigger.  The entered value is saved 
in the default configuration so that care must be taken to reset this value for each recording session. 
 
Image-cueing greatly increases the triggering capabilities of GigaView and makes more efficient use of the 
available memory.  As described in section 4.3.8 above, image-cueing is compatible with autonomous operation 
of GigaView.  Custom image processing or triggering tasks can be accomplished in addition to those described 
here.  Please contact Southern Vision Systems for custom applications. 
 
 
5.4 MULTIPLE SECTOR RECORD 

This feature allows the memory to be partitioned between up to 16 identical sectors in order to record 16 events 
occurring too rapidly in time to download imagery between events.  In this manner, one GigaView camera can 
perform the task of 16 different cameras.  Minimum sector size is 512-MB so that a 1-GB camera can record up 
to two events and a 16-GB camera can record up to 32 events. 
 
The user selects the sector size, number of sectors to record, and the trigger mechanism for starting the 
recording process.  Once the trigger condition has been met and the first sector is full, GigaView resets itself 
within one frame period, moves to the next sector, and waits for the same trigger condition again before 
recording.  A log file with the time of each sector’s trigger is stored on the host computer after recording is 
finished. 
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As seen in Figure 19 below, an “inter-sector trigger lockout” time can be specified during which an image-cued 
or external trigger will be ignored.  This feature is useful, for example, when multiple events are being recorded 
based on an image-cued trigger but the camera resets itself too fast for the triggering event to complete. 
 

 
Figure 19  Memory sector definition window. 

 
For the example above, memory is divided into two sectors each 512-MB.  Between recording of the first and 
second sector, there is a 1-sec lockout period in which neither an image-cued trigger nor an external TTL trigger 
will be recognized.  This lockout period is saved in the default configuration file so that care must be taken to 
reset this value for each recording session.   
 
 
5.5 AUTO-EXPOSURE 

Video recording performed outside or over long periods of time may benefit from the auto-exposure feature of 
GigaView.  For auto-exposure mode, the average intensity of each image is sampled during the record process 
and the electronics shutter varied between each consecutive frame to keep this average intensity close to the 
target average intensity.   
 
Prior to implementing the auto-exposure feature outside of the Record Wizard, it is necessary to record a brief 
sequence of images.  This gives GigaView a target intensity for which to control the exposure.  After recording 
a brief sequence under target conditions and selecting an appropriate frame from the sequence, the user is given 
the ability to enforce upper and lower exposures as in Figure 20 below.  Auto-exposure is enabled using the 
following procedure: 
 

1. Record a brief sequence of images at the appropriate frame-size, frame-rate, exposure, and 
illumination. 

2. Select an image of the appropriate average intensity from the video sequence. 
3. Click on [Lighting Auto-exposure] and select the “Auto-exposure” check-box under the “Auto-

exposure Settings” window. 
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Figure 20  Auto-exposure settings window. 

 
4. Enter the minimum and maximum exposures over which the electronic shutter is allowed to 

vary.  The minimum exposure is 2-µsec while maximum exposure is 1/frame-rate.  
5. Start [Record] mode and the exposure shown under “Video Settings” of the [Record] page can be 

seen to vary between the minimum and maximum as lighting conditions change.   
 

Any video sequence taken with [Auto-exposure] enabled should be assumed to have different exposures for 
different frames.  These exposure values are encoded in each frame of the video so that a frame-by-frame 
exposure value is seen on the “Play” page when playing back the video. 
 
 
5.6 IRIG-B TIMING 

With the optional IRIG-B upgrade to MemView, exact timing relative to the modulated IRIG-B input signal can 
be determined for all frames.  This option is commonly used for military applications and provides precise 
timing relative to other events or equipment. 
 
Amplitude-modulated IRIG-B is input through the “IRIG-B” BNC connector on the rear panel.  MemView 
takes this signal and strips out the date (minus year) and time and displays this information to within 0.1-µsec.  
The IRIG-B format does not encode the year so that the user must enter current year under the menu item 
“Camera”->”Set IRIG time…” of the [Record] page.  With the current year and a valid AM IRIG-B signal, each 
frame of a record sequence is stamped with a time that corresponds to the start of exposure.  This information is 
stored in the first 10-pixels of every frame and replaces the intensity data.  In addition, an optional auxiliary 
data text file can be created containing comma-separated values for frame number and absolute time during the 
File save process.  This file can be opened in Excel or a text-editor.  IRIG timing is also shown as text overlay 
on the RS-170 analog video output. 
 
(Note: the MemView software recognizes an IRIG-enabled camera based on its serial number.  If no valid IRIG 
signal is input to such a camera, the time values stored will be meaningless.) 
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5.7 REMOTE OPERATION 

Since your GigaView camera is a true (TCP/IP) networked device, it can be accessed and controlled over the 
internet with no host computer present locally.  In order to do this, SVSi recommends that a router be used to 
act as a firewall to the camera to prevent unauthorized access.  GigaView is set up to use port number 2322.  By 
entering the router’s IP address when connecting to the camera with the GigaView software, access will be 
granted to any computer with the installed software.  Note that bandwidths over the internet will be significantly 
lower than that at which GigaView is capable.  
 
GigaView can also be controlled remotely using any remote desktop application that supports 32-bit display 
depths.  Windows Remote Desktop does not support 32-bit display but several others do (including VNC 
Viewer) and have been used successfully.  To control through a remote desktop application, start the GigaView 
GUI and connect directly to the GigaView camera.  Once the software is running and acquiring images, logging 
on to the host computer via remote desktop will allow control of the camera.  However, the same connection 
that downloads imagery to the host also uploads imagery to the remote user so bandwidths will be lower. 
 
 
Please contact Southern Vision Systems, Inc. at sales@southernvisionsystems.com or (256) 461-7143 for 
pricing and delivery or for custom image processing applications. 
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Appendix A:  Troubleshooting 
 
The following table describes problem conditions you may encounter with the GigaView camera and suggested 
actions to resolve these problems. 
 
 
 

Problem Action 
  
Program will not initialize. Check to see that power cable is connected to 

camera and that the ethernet cable is 
connected to the camera and computer.  If still 
not initializing, unplug power connector to 
camera, re-connect, and re-start software.  If 
this fails, contact factory. 

  
Camera will not activate and gives “GigaView 
Device Error” 

Typically indicates a hardware error.  This can 
happen if the camera electronics have been 
disassembled.  Contact factory. 

 
[Live] or [Record] on “Record” page only shows 
black frames. 

 
Check that the exposure is high enough to 
detect the ambient light level and that the 
adjustable aperture is open enough to admit 
light. 

 
Camera does not appear to update with new 
images after clicking [Live] or [Record]. 

 
GigaView remembers previous settings and 
stores these to an inf file.  Check that [External 
Trigger] or [Frame Sync] is not inadvertently 
selected.  If still not responding, contact 
factory. 

 
[Live] or [Record] on “Record” page only shows 
gray frames but video plays back OK. 
 

 
Ensure that Color (32-bit) is selected in 
“Display Properties” by right-clicking on 
desktop, selecting “Properties” and then 
“Settings” tab.   

 
Error message “Insufficient hard disk space” 
appears during save of AVI, GigaView raw, or 
image sequence. 
 

 
Not enough disk space.  Delete unused files on 
the host computer and retry. 

 
Video stored on “Record” page has vertical 
lines or torn frames even though live video 
looks OK. 

 
Typically means camera has lost synch during 
download.  Images stored in memory on the 
camera should be OK.  Under the “Camera” 
menu item on “Record” page, click [Reset 
Camera].  This will not erase stored video.  
After the reset is complete, download the 
imagery data.  If this does not work, contact 
technical support. 

 
No video data is displayed during the record 
but the camera appears to be capturing data. 
 
 

 
Your video display depth needs to be set to 
32bit.  Right click on your desktop and 
selecting properties.  Next select the “Settings” 
tab and set the display depth to 32-bits. 
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When playing a GigaView RAW file, no video 
data is displayed. 

 
Your video display depth needs to be set to 32-
bit.  Rght click on your desktop and selecting 
properties.  Next select the “Settings” tab and 
set the display depth to 32bits. 

 
Trigger settings indicate 100% pre- or post-
trigger with no way to change settings. 

 
The drag bar is moved all the way left or right.  
Position cursor over the left or right end of the 
trigger settings drag bar until you see the”<->” 
indicator, then click and drag bar to desired 
position. 

 
GigaView’s real-time clock does not seem to 
be working with frames referenced to t=0. 

 
If video is recorded during automatic start-up 
before GigaView has had time to connect to 
the host, then t=0 is defined to be immediately 
after power-up. 

 
Frames are torn or displaced after a recording 
session. 

 
Memory address locator may be off slightly.  
Save the video and open in Record page.  
Frames should now be synchronized.  If not, 
please contact the factory. 

 
“Fail to get camera status” error message after 
[Camera->Reset Camera] command. 

 
Try resetting camera again.  If software 
continues to fail getting camera status, please 
contact the factory. 

 
Recorded video has vertical lines after [Stop] is 
selected. 

 
Lines will disappear when [Play] is selected.  If 
they persist, select [Camera->Reset Camera].  
If lines still persist, please contact factory. 

 
 
 
For technical support, contact techsupport@southernvisionsystems.com or call (256) 461-7143. 


